USING MICROSOFT OUTLOOK 2016

USER’S GUIDE

FEBRUARY 2016
© 2016 UNIVERSITY OF SOUTHERN CALIFORNIA. All rights reserved.

This manual, as well as the data and software implementation described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment on the part of the University of Southern California.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of the University of Southern California.

The data and software implementation, as with all technical and computer-aided design software, is a tool intended to be used by trained professionals only. The data and the software implementation is not a substitute for the professional judgment of trained professionals. The software implementation is intended to assist with product design and is not a substitute for independent testing of product stress, safety and utility. The University of Southern California assumes no liability for any error or inaccuracies that may appear in this manual. The University of Southern California makes no warranties with respect to this manual and disclaims any implied warranties of merchantability and fitness for a particular purpose.

U.S. Government Customers:

The Products are provided to the Federal government and its agency with RESTRICTED RIGHTS. USE, DUPLICATION OR DISCLOSURE BY THE GOVERNMENT IS SUBJECT TO RESTRICTIONS SET FORTH IN SUB-PARAGRAPH (c)(1)(ii) OF THE RIGHTS IN TECHNICAL DATA AND COMPUTER SOFTWARE CLAUSE AT DFARS 252.227-7013 OR SUB-PARAGRAPHS (c)(1) OR (2) OF THE COMMERCIAL COMPUTER SOFTWARE-RESTRICTED RIGHTS AT 48 CFR 52.227-19, AS APPLICABLE.
# TABLE OF CONTENTS

Using Microsoft Outlook 2016

- Accessing Your Email Using the Outlook 2016 Software Application ......................................................... 1
- Accessing Your Email Using a Web Browser (Outlook Web Access) .............................................................. 2
- Accessing Your E-mail on a Mobile Device ......................................................................................................... 3
- Accessing an Organizational or Resource Account .......................................................................................... 23
- Changing an Item Type ........................................................................................................................................ 27
- Changing the From Address in a New Email ...................................................................................................... 29
- Changing the Subject Line of a Received Email Message .................................................................................. 35
- Configuring Your Junk Email (SPAM) Settings ................................................................................................ 37
  - Changing the Junk Mail Settings in OWA ...................................................................................................... 39
- Creating Recurring Appointments .................................................................................................................. 43
- Creating Rules and Signatures ........................................................................................................................ 47
  - Creating a Rule ................................................................................................................................................. 47
  - Creating an Email Signature .......................................................................................................................... 51
- Creating a Mail Merge Document .................................................................................................................... 55
- Creating a Mail Merge ................................................................................................................................. 55
- Creating and Accessing Your Personal Archive ............................................................................................. 63
  - Creating Your Personal Archive .................................................................................................................... 63
  - Accessing Your Personal Archive .................................................................................................................. 66
- Displaying Emails as Discussion Threads ..................................................................................................... 69
- Giving and Receiving Delegate Access .......................................................................................................... 71
  - Giving Delegate Access ................................................................................................................................. 71
  - Receiving Delegate Access ........................................................................................................................... 74
  - Revoking Delegate Access ............................................................................................................................ 75
- Posting a Message in a Folder .......................................................................................................................... 77
- Resending an Email Message .......................................................................................................................... 83
- Searching Microsoft Outlook .......................................................................................................................... 85
- Sending An Email To Shared Contacts .......................................................................................................... 86
  - Sharing Contacts with a Person in Your Organization ............................................................................... 86
  - Access Shared Contacts ............................................................................................................................... 89

Contact Dornsife Technology Services ........................................................................................................ 92
USING MICROSOFT OUTLOOK 2016

You have the ability to access your USC and Dornsife email accounts in a variety of ways. You can utilize the Microsoft Outlook 2016 software application on your workstation (desktop or laptop), the Outlook Web Access (OWA) via a web browser, and you can access your email via mobile applications on iOS, Android, and Blackberry devices. Use this guide to assist you in accessing your email via one of the supported formats.

Accessing Your Email Using the Outlook 2016 Software Application

Accessing your USC and/or Dornsife e-mail account(s) through the Microsoft Outlook software application on your workstation is simple. Located the program icon. The program icon will either be on your workstation's desktop or in the Windows Start Menu. An example of how the icon appears is displayed below.

Launch the application by double-clicking the icon. The first time you launch the Outlook 2016 software application, there may be a small delay in the display of the application or the contents of your mailbox, as the software application syncs with the email server. Your Outlook inbox will appear similar to the following image, when the application has completed syncing with the email server and is ready for use.
Accessing Your Email Using a Web Browser (Outlook Web Access)

If you are away from the computer on which you normally access Outlook, or you want to utilize the Internet-based option exclusively, the Outlook Web Application (OWA) is a fast and easy way to access your e-mail using a web browser.

Complete the following steps to access your email account using a web browser.


   ![Authentication Required dialog box](image1)

2. Enter your email address in the User Name: field and the corresponding password in the Password: field. An example is shown below, though the box may be slightly different in appearance depending upon which web browser you utilize.

   ![Authentication Required dialog box](image2)
3. Select the OK button. The *Outlook Web Application (OWA)* displays similarly to the following example.

You can access your e-mails, personal folders, and calendar from the Outlook Web Application. OWA and the desktop version of Outlook are identical kept that way through cloud-based syncing.

**Accessing Your E-mail on a Mobile Device**

You can access your USC and/or Dornsife email accounts from any of the following mobile devices. You can also access your email using any ActiveSync email system or device that might not be listed.

- Android
- Blackberry 10
- iOS (iPad/iPhone/iPod Touch)
- Windows Mobile Device (tablet or phone)

Mobile devices that use POP or IMAP email settings are not supported. If your mobile device does not support ActiveSync, you can still access your USC email through a supported mobile browser.
Configuring Your USC Email Account for Use on an Android Device

Follow the steps below to configure the email client on your Android device for use with your USC and/or Dornsife email account(s).

1. Open the device **Settings** menu. The **Settings** display.

![Image of Settings menu with Add account highlighted](image-url)
2. Select the **Add account** option. The *Add an Account* screen displays.

3. Select the **Email** option. A secondary menu displays.
4. Select the **Microsoft Exchange ActiveSync** option. On some devices, this option may be presented as **Exchange**, **Corporate**, or **ActiveSync**. The **Account Setup** screen displays.
5. On the **Account Setup** screen, enter your email address and the corresponding password in the appropriate fields. In the **Server** field, enter **m.outlook.com**. The other fields on the screen should have automatically populated. Select the **Next** option. The **Account Settings** screen displays.
6. Configure your email options as you desire. You can select which options to sync and how/when you want to receive new email notifications. When you have finished making selections, select the **Next** option. The **Account Name** screen displays.
7. Give your email account a name, if you desire. This name will help you identify the account, if you have multiple email accounts on your device. This step is optional. Select the Next button to complete the email configuration process. Your inbox displays.

Your USC email address is now configured for use with your Android device.
Configuring Your USC Email Account for Use on a Blackberry Device

Follow the steps below to configure the email client on your Blackberry device for use with your USC and/or Dornsife email account(s).

1. Open the *System Settings* menu for your Blackberry Device. A menu displays.
2. Select the **Accounts** option, located in the middle of the menu. The *Add Account* screen displays.

![Add Account Screen](image)

3. Select the **Email, Calendar and Contacts** option from the *Add Account* menu. The next screen displays.

![Add Account Screen](image)
4. Enter your USC email address in the *Email Address* field. Enter the entire email address. Use the picture above as an example. After entering your USC email address in the appropriate field, select the **Next** option, located at the top of the screen. Your Blackberry device attempts to locate your connection information based on the email address you have entered.

![Add Account](image1.png)

5. Next, you will be prompted to enter the password that corresponds to your email address. Enter your password in the appropriate field and then select the **Next** option. A notice about *Advanced Options* displayed.

![Add Account](image2.png)
6. Setting up your USC email account on your Blackberry device may require the use of the Advanced Settings options. A notice to this effect displays. Select the OK option.

7. Next, select the Advanced option, located at the bottom of the screen. A menu displays.
8. Select the **Microsoft Exchange ActiveSync** option, located near the top of the screen. The *Add Account* screen displays.
9. There are multiple fields on the *Add Account* screen. Scroll down the screen to the *Server Address* field and enter *m.outlook.com* into the *Server Address* field. Then, select the *Next* option.
10. The server address you entered will be verified by the email configuration process.
11. When the server address has been verified, you will be prompted to select the items you want to sync with your account. By default, all options are enabled. If you do not want to sync one of the items, slide the adjacent bar to the left to disable the syncing of that item.

12. When you are finished selecting items to sync, select the **Done** option, located at the top of the screen. A summary of your email account information is displayed.

Your USC email address is now configured for use with your Blackberry device.
Configuring your USC Email Account for Use on an iOS Device
Use the following instructions to configure your USC email account for use with your iOS (iPad, iPhone, iPod Touch) device.

1. From the desktop of your device, select the mail icon. This icon will be located on the desktop or in the dock, at the bottom of the screen.

2. If you already have an email account configured on this device, you will need to navigate to Settings > Mail, Contacts, Calendars > Add Account.

3. The Welcome to Mail screen displays.
4. Select the **Exchange** option. You will be prompted to enter your email address and password.

5. Enter your USC email address and the corresponding password, in the appropriate fields. Enter a description in the *Description* field that will help you identify this account. Then, select the **Next** option.
6. The last screen in the configuration process provides the ability to select which items you want to sync: Contacts, Calendars, Reminders, or Notes. You can select as many or as few of these options, as you desire. By default, all items are enabled for syncing. Make any changes to the items to sync, and then select the Save option.

Your USC email address is now configured for use with your iOS device.

Configuring your USC Email Account for Use on a Windows Mobile Device

Follow the steps below to configure the email client on your Windows mobile device for use with your USC and/or Dornsife email account(s).

1. Select the Settings icon from your desktop. The Settings icon may appear similar to the following. The Add Account screen displays.

![Settings Icon]

2. From the Add Account screen, select the Exchange option. The Exchange screen displays.

![Add Account Screen]
3. On the *Exchange* screen, enter your USC email address and the corresponding password. Then, select the **sign in** option, located at the bottom of the screen.
4. Your email account has been added to your device. A confirmation screen displays.

5. Select the done option, located at the bottom of the screen. The configuration process is now complete.

Your USC email address is now configured for use with your Windows device.
ACCESSING AN ORGANIZATIONAL OR RESOURCE ACCOUNT

If you have permissions to view or edit an organizational account (e.g., a department email address that is not associated with a particular person) or resource account (e.g., a conference or meeting room calendar for scheduling), you will want to access that account via Microsoft Outlook. Complete the following steps to access the organizational or resource account in Outlook.

1. Launch Microsoft Outlook and then select the File tab.
2. Next, select the Account Settings button. A drop-down menu displays.
3. Select **Account Settings...** from the drop-down menu. The **Account Settings** screen displays.
4. Select the **Change...** button, located near the center of the *Account Settings* screen. The *Change Account* window displays.
5. Select the **More Settings...** button. The *Microsoft Exchange* window displays.

![Microsoft Exchange window](image)

6. Select the **Advanced** tab.

7. On the **Advanced** tab, select the **Add...** button. The *Add Mailbox* window displays.

![Add Mailbox window](image)

8. Enter the name of the organizational or resource account you want to view in Outlook in the **Add mailbox:** field, and then select the **OK** button.

The organizational or resource account now appears below the folders list, located on the left side of the Outlook window.
CHANGING AN ITEM TYPE

Often, email discussions will lead to a face-to-face meeting, or you will want to retain a message history with a particular contact in your address book. Microsoft Outlook provides the ability to change an item type from one form to another. This allows you to keep all of your relevant email history, but transfer it to an appointment you need to create.

Complete the following steps to change an item type. For the purposes of this document, an email message will be changed to an appointment. The steps are the same to change any item type from one to another.

1. Open Outlook and select an email message to change to an appointment type. Hold your left mouse button down and drag the e-mail message to the Calendar icon, located on the left side of the screen. The mouse cursor displays a square with a + symbol in the center.

2. Release the left mouse button. A new calendar appointment displays and contains all of the message history from the e-mail.
CHANGING THE FROM ADDRESS OF EMAIL

CHANGING THE FROM ADDRESS IN A NEW EMAIL

If you have access to an organizational email account, you can change the From address to reflect that email address, when sending emails from that account. Follow the steps in this topic to change the From address on an outgoing email.

NOTE: You can change the From address for accounts to which you have been granted delegate access. However, the email will come On Behalf Of the account to which you have been granted delegate access. Your email address will also be displayed. Only organizational accounts can change the From address in a way that does not reveal the sender's own email address.

1. Open Outlook and then open a blank email.

2. Select the Options tab. The Options tab displays.
3. Select the From button located in the Show Fields section of the toolbar. The drop-down menu displays.

4. The drop-down menu displays two options: your own email address and a Other E-mail Address option. Select the Other E-mail Address option. The Send from Other E-mail Address screen displays.
5. The *Send from Other E-mail Address* screen provides the ability to select the email address from which you want this email to be sent. Select the From... button. The *Choose Sender* screen displays.

6. On the *Choose Sender* screen, select the Address Book drop-down menu. Then, select the Global Address List from the drop-down menu choices.

7. In the Search field, at the top of the *Choose Sender* screen, begin typing the email address from which you want to send the email.
8. Locate the email address and select it with your cursor. Then, select the OK button.

9. The Choose Sender screen closes and the Send from Other E-mail Address screen is displayed again. The email address that your chose as the From address is now displayed on the Send from Other E-mail Address screen.
10. Select the **OK** button. The blank email displays the new **From** address.

Repeat these steps as is necessary.
CHANGING THE SUBJECT LINE OF A RECEIVED EMAIL MESSAGE

Email messages often contain information that you will want to reference in the future. However, the e-mail's original subject line may not contain text that will assist you in easily identifying the e-mail in your email filing system. Microsoft Outlook provides the ability to change the subject line of an e-mail you have received.

Complete the following steps to change the subject line of a received email.

1. Open the email for which you want to change the subject line. The email displays.

2. Highlight the existing subject line of the received email, as shown in the picture above.

3. Begin typing the new subject line of the received email. Your text will replace the original/existing title of the received email.
4. When you are finished entering the new text, select the **Save** icon at the top of the e-mail.

5. Alternately, if you attempt to close the email without first saving the new title, Outlook will prompt you to save your changes.

Repeat these steps to change the titles of additional received email messages.
CONFIGURING YOUR JUNK EMAIL (SPAM) SETTINGS

ITS SPAM filters emails as they cross the email server. This process flags and removes the majority of SPAM messages, before they arrive in your inbox. Microsoft Outlook contains its own SPAM filtering capabilities. However, some emails that are not SPAM may be incorrectly identified as SPAM, because of the double filtering process. To avoid legitimate emails being identified as SPAM, you will need to disable SPAM filtering capabilities in Outlook. Complete the following steps to configure your Junk Email (SPAM) settings in order to ensure optimal email delivery results.


   ![Microsoft Outlook screenshot](image)

   2. On the **Home** tab, select the **Junk** option. A drop-down menu displays.
3. From the drop-down menu, select **Junk Email Options**... The *Junk Email Options* screen displays.

4. Select the **No Automatic Filter** radio button. Then, click the **OK** button to apply the setting change.

---

**NOTE:**
The same settings change must be made in the web-based version of Outlook, as well, in order for the Junk Email settings to function correctly.
Changing the Junk Mail Settings in OWA

1. Open a web browser and navigate to http://dornsife.usc.edu/365. The Outlook Web Application (OWA) will prompt you to log into the website.

2. Enter your USC email address in the User Name: field.

3. Enter the corresponding password in the Password: field.

4. After entering your email address and the corresponding password, select the OK button. OWA displays.
5. Select the **Gear** icon, located on the right side of the screen. A drop-down menu displays.
6. From the drop-down menu, select the **Options** item. The **Options** screen displays.
7. In the sidebar of the *Options* page is a menu. Expand the *Accounts* menu and then select *Block or allow*. The *Block or allow* options display.

8. Select the **Don't move email to my Junk Email folder** radio button, located at the top of the screen.

9. After selecting the radio button, select the *Save* option, located at the top of the screen.

Your Junk Email settings are now properly configured. Repeat these steps as-is appropriate.
CREATING RECURRING APPOINTMENTS

Some meetings are a one-time occurrence. Other meetings, such as staff or departmental meetings, may recur at specific intervals throughout the year. Microsoft® Outlook® provides the ability to create recurring appointments in the Calendar.

Complete the following steps to create a recurring appointment.

1. Launch Outlook and open your calendar.

The calendar displays.
2. Next, select the **New Appointment** icon.

The **Untitled - Appointment** window displays

3. Enter the meeting information, such as the location, date, time, and the subject of the meeting. If you are inviting other people to your meeting, select the **Invite Attendees** icon and add the appropriate individual(s) to your meeting.

4. After entering the appropriate information for the meeting, select the **Recurrence** icon, located at the top of the screen.

The **Appointment Recurrence** window displays.
5. The *Appointment Recurrence* window provides the ability to define the meeting's recurrence pattern. The recurrence must have a pattern. There is no ability to create a recurring meeting that does not repeat in a patterned manner.

![Appointment Recurrence window](image)

6. Configure the appropriate recurrence options for your meeting. When you have finished, select the **OK** button.

7. After completing adding information to your meeting, select the **Save & Close** icon at the top of the window.

The recurring appointment now appears on your calendar.

Repeat these steps for each additional recurring meeting you want to create.
Microsoft® Outlook® supports the use of rules and e-mail signatures. This document outlines how to create a rule and an e-mail signature.

Creating a Rule
Complete the following steps to create a rule.

1. Launch Outlook and select the **File** tab.

   ![File tab](image)

   The **File** tab displays.
2. Next, select the **Manage Rules & Alerts** button.

The *Rules and Alerts* window displays.
3. On the *Rules and Alerts* window, select **New Rule**...

The *Rules Wizard* window displays.

4. Use the *Rules Wizard* window to create and configure any rules you want to apply to your mailbox.
5. After selecting the Rule you want to configure, select the **Next** button to step through the configuration screens.

6. When you have finished configuring the desired Rule, select the **Finish** button to exit the *Rules Wizard* screen.

Repeat these steps to configure additional Rules.
Creating an Email Signature

Creating an email signature provides a quick way to include your contact information in emails that you send. Complete the following steps to create an email signature.

1. Launch Outlook and select the **File** tab.

![File tab in Outlook](image1.png)

2. Then, select **Options** on the left side of the screen.

![Options in Outlook Options window](image2.png)

The **Outlook Options** screen displays.

3. Select the **Mail** option on the left side of the **Outlook Options** window.
4. Then, select the **Signatures...** button.

The **Signatures and Stationary** window displays.
5. Use the *Signatures and Stationary* window to create an e-mail signature and set the automatic application rules (optional).

You can create multiple e-mail signatures within Outlook. Repeat these steps as necessary.
CREATING A MAIL MERGE DOCUMENT

The Mail Merge function provides the ability to create a personalized document that you will send to multiple recipients. To complete all the steps of the Mail Merge process, you will need both Microsoft Word and Microsoft Outlook 2016.

Creating a Mail Merge

Complete the following steps to create a Mail Merge.

1. Open Microsoft Word.
2. Open a blank document.
3. Select the Mailings tab at the top of the screen. The Mailings toolbar displays...
4. Select the **Start Mail Merge** button, located in the **Mailings** toolbar. A drop-down menu displays.

5. From the drop-down menu, select an option. Each option will be similar in process, but will contain individual steps that are specific to that process. For this example, **E-mail Messages** will be selected.

6. Next, select the **Select Recipients** button. A drop-down menu displays.

7. There are three (3) ways to select the recipients for your Mail Merge email. You can manually **Type a New List**, **Use an Existing List**, or **Choose from Outlook Contacts**. The recommended Mail Merge method is to use an Excel spreadsheet. This provides better control of the address information and how that information appears in your email. Create an Excel spreadsheet of the address data before you begin the Mail Merge process.
Select **Use an Existing List...** from the drop-down menu. A **Browse** screen displays.

8. Navigate to the location of your Excel spreadsheet and select the file. Then, select the **Open** button. The **Select Table** screen displays.

9. The **Select Table** screen displays the tab name that contains data in the Excel spreadsheet you selected.
10. Select the **First row of data contains column headers** checkbox to tell Excel to skip the first row of the spreadsheet because it contains column names, if applicable.

11. Select the **OK** button. The **Select Table** screen closes.

12. In the blank Word document that is displayed, begin typing the email you want to send. If you have already composed this email, you can copy and paste it from another source.

13. After you have composed the email, you will begin to insert the Mail Merge fields. This will map the data within your Excel spreadsheet to a location within your email.

14. Select the **Mailings** tab, located in the **Word** toolbar, if it is not still selected.

15. Next, place your cursor in the location that you want to insert the first Mail Merge field.

16. Select the **Insert Merge Field** option. A drop-down menu displays.
17. The Insert Merge Field drop-down menu displays the names of your Excel spread sheet column headings. If your spreadsheet does not contain column headings, you will want to add them, and then re-import the Excel spreadsheet before continuing.

18. Select the column name that you want to insert in the location where you previously placed your cursor in the Word document. The Mail Merge field is inserted.

Dear {FirstName},

I would like you to be my guest at the housewarming party that I'm hosting. The time and place of the party are listed below. We hope that you will be able to attend.

1234 Yemen Road
March 1, 2016
6:00PM

Dinner provided. Please come and share a meal with us, so we can begin to get to know one another. Feel free to bring along a friend. This would be a great opportunity for you to invite someone in the neighborhood that we have not yet met!

Sincerely,

Elizabeth Bennett
19. Next, select the **Match Fields** button, located in the **Write & Insert Fields** area of the Word toolbar. The **Match Fields** screen displays.

![Match Fields screen](image)

20. Scroll through the fields listed on the **Match Fields** screen. Verify that the spreadsheet headings have been correctly correlated to the **Mail Merge** fields. When you have completed the verification of the field matches, select the **OK** button.

21. You are now ready to preview the Mail Merge. You do not have to preview the Mail Merge, but it is a good idea to make certain that the Mail Merge has worked successfully. Select the **Preview Results** option in the Word toolbar.

![Preview Results option](image)
22. Word displays a preview of how the Mail Merged documents will appear. The Mail Merge fields have been converted to actual data.

23. If the Mail Merge preview look accurate, then you are now ready to complete the Mail Merge process. Select the **Finish & Merge** option from the *Word* toolbar. A drop-down menu displays.
24. From the drop-down menu, select the way in which you would like to send your messages.
   - **Edit Individual Documents:** Select this item to edit each individual letter within the Mail Merge.
   - **Print Documents:** Select this item to send the Mail Merge documents to the printer.
   - **Send Email Messages...:** Select this item to send the letter via email.

   For this example, **Send Email Messages...** will be selected. The *Merge to E-mail* screen displays

25. The *Merge to E-mail* screen provides the ability to designate to whom the emails will be sent. Your Excel spreadsheet should contain a column containing the email address of each recipient. In the example below, the To: field is set to Email, because that is the header name in the Excel spreadsheet. After selecting the appropriate Excel spreadsheet column name, enter a **Subject line** in the corresponding field. Then, you will need to select a **Mail format**. HTML is selected by default. You may leave that option as-is or you may select a new option from the corresponding drop-down menu.

   The **Send records** section provides the ability to select which documents in your Mail Merge to send via email. You can select **All**, to email all of the documents in the Mail Merge. You can select **Current record** which will send only the document currently displayed on your screen. You can select the **From:** and **To:** option to designate a page range to be emailed.

   ![Merge to E-mail screen](image)

26. Select the options that are appropriate for your needs, and then select the **OK** button.

   The documents should begin being emailed from Microsoft Outlook. The Mail Merge process is complete. Repeat these steps to create additional Mail Merges.
CREATING AND ACCESSING YOUR PERSONAL ARCHIVE

Creating a personal archive of your e-mail messages is a great way to keep a record of communications that you may need to reference in the future. You can designate the frequency at which messages are archived, and access them as needed.

Creating Your Personal Archive

1. Launch Microsoft Outlook and right-click on the Inbox folder, located on the left side of the screen.

A pop-up menu displays.
2. From the pop-up menu, select **Properties...** The *Inbox Properties* window displays.
3. Select the **Policy** tab. At the bottom of the **Policy** tab is the *Online Archive* section.

![Inbox Properties](image)

4. Select the **Move Items to the Archive when older than:** drop-down menu to select the frequency with which items are to be archived. After selecting a frequency, select the **OK** button to save your selection.

**NOTE:** The Parent Folder Policy is an option that can be selected in the **Move Items to the Archive when older than:** drop-down menu. The Parent Folder Policy in this scenario is to never archive items.

Creating a personal archive is now complete.
Accessing Your Personal Archive

After creating your personal archive, you will want to access the information in the archive.

1. Launch Microsoft Outlook. Select the **Home** tab if it is not already selected.
2. Located in the menu on the left side of the screen is an option that appears similarly to the following: online archive - yourUSCID@dornsife.usc.edu. Expand this option to view and access your personal archive. An example is shown below.

![Example of online archive]

Repeat these steps to access your personal archive folders.
DISPLAYING AN EMAIL AS A DISCUSSION THREAD

DISPLAYING EMAILS AS DISCUSSION THREADS

In an effort to link stored messages that are related, Microsoft® Outlook® can display the e-mails as conversations. You can enable this setting for all folders in your mailbox or for a single folder.

1. From the Outlook main tool bar, select the View tab. The View tab displays.

2. Next, select the folder to which you want to apply the setting from the folder list on the left side of the screen. By default, your inbox will be selected. You may choose a different folder.

3. Select the Show as Conversations checkbox. After selecting the Show as Conversations checkbox, a window displays that provides the ability to apply this feature to all folders or only a specific folder in your mailbox. Select the option you want to apply.
4. After making the appropriate selection, the **Reading Pane** (the area that displays your e-mail messages) displays the messages in a collapsed view. Expand the conversation to view all the messages nested within the conversation.

Repeat these steps for other folders, as is appropriate.
GIVING AND RECEIVING DELEGATE ACCESS

Delegate access is granted to individuals who will manage certain aspects of Microsoft Outlook for another person. For example, a delegate may have permission to send email messages on behalf of another person, or to manage a person's calendar.

Giving Delegate Access
To grant an individual(s) delegate access, complete the following steps.

1. Launch Outlook and select the **File** tab.

2. Next, select **Account Settings**. A drop-down menu displays.
3. Select **Delegate Access** from the drop-down menu. The **Delegates** screen displays.

4. On the **Delegates** screen, select the **Add...** button. The **Add Users** screen displays.
5. Locate the name of the person to which you want to grant delegate access.

6. Highlight their name by selecting it with your mouse cursor.

7. Select the Add -> button.

8. Select the OK button. The Delegate Permissions screen displays.
9. Select the appropriate permissions for the person to whom you are granting delegate access. When you are finished, select the **OK** button. The *Delegates* screen displays.

10. Select the **OK** button.

You have now successfully granted delegate access to the desired individual. Repeat these steps to grant delegate access to additional people.

**Receiving Delegate Access**

Receiving delegate access is very simple. All you must do to access the items to which you have been granted access, is open the item. See the *Accessing an Organizational or Resource Account in Outlook* help topic for information on accessing your delegated items.
Revoking Delegate Access

From time-to-time, you may need to revoke delegate access you have granted. For instance, a delegate may receive a promotion or leave the organization, and you would want to rescind the delegate access. Complete the following steps to revoke delegate access after it has been granted.

1. Launch Outlook and select the File tab.

2. Next, select Account Settings. A drop-down menu displays.
3. Select **Delegate Access** from the drop-down menu. The **Delegates** screen displays.

![Delegates Screen]

4. Highlight the name of the delegate you want to remove.

5. Select the **Remove** button. The name of the delegate is removed from the **Delegates** screen.

6. Select the **OK** button. The **Delegates** screen closes.

The delegate access has been revoked. Repeat this process to remove delegate access from additional people.
POSTING A MESSAGE IN A FOLDER

The Post in This Folder feature provides the ability to post a note, generally to oneself, in any folder in your Microsoft® Outlook® mailbox. In order to post a message in any folder of your choosing, you will need to add the option to your Outlook tool bar.

To add the Post in this Folder icon to your tool bar, complete the following steps.

1. Open Outlook and verify that the Home tab is selected. Then, right-click with your mouse anywhere in the tool bar. A pop-up menu displays.
2. Select **Customize the Ribbon**... The term *ribbon* and *toolbar* are synonyms and may be used interchangeably throughout this topic. The *Outlook Options* window displays.
3. In the center of the *Outlook Options* window are two columns. In the **Choose commands from:** drop-down menu above the left column, select **All Commands**.
4. New options are now displayed in the left column. Scroll through the options and highlight **Post in This Folder**. Next, select the **New Group** button, located under the right column.
5. Select the **Add >>** button, located in between the two columns. **Post in This Folder** is displayed in the **New Group** you created.

6. Select the **OK** button at the bottom of the window. A **Post in This Folder** icon is now displayed in the Outlook toolbar.

You now have the ability to post a message in any folder in your mailbox, quickly and easily, using the newly added icon.
Occasionally, the need to resend an email message may arise. Resending an email is a time saver, as you do not have to retype the information in the email, or even copy and paste the contents. Microsoft® Outlook® contains a built-in feature that provides the ability to resend a message that has previously been sent.

1. To re-send a message, select the Sent Items folder and locate the e-mail that you want to re-send.

2. Open the e-mail you want to re-send. Then, select Actions from the Move menu in the tool bar. A drop-down menu displays.
3. From the drop-down menu, select **Resend This Message**. A new e-mail message, containing all the text and message history of the original message, is created and addressed to the original recipient. You can now send this message just as it is, add additional recipients, or edit it the message content.

Repeat these steps for each e-mail you want to re-send.
Microsoft Outlook provides a variety of search options to assist you in locating the specific item you seek. Each folder within your mailbox contains a contextual search bar. An example of how to access the contextual search bar is below.

Select the Trash folder located in the menu on the left side of the screen. A contextual search field (i.e., a field that will search the specific folder you selected) displays.

Place your cursor inside the contextual search field. After placing your cursor in the contextual search field, a new tool bar menu, Search Tools, displays.

The Search Tools menu provides a variety of additional search options and methods. You can use the contextual search field to search the folder you selected for a specific item. You can also use one of the more advanced search options available from the Search Tools menu. For example, if the e-mail message for which you are searching has an attachment, you can select the Has Attachments option to filter your search results by e-mail messages containing attachments.
SENDING AN EMAIL TO SHARED CONTACTS

Explore all of the options available on the Search Tools menu to assist you in locating the message you seek.

Selecting an e-mail or folder de-activates the contextual search field and the Search Tools menu. Place the cursor back in the contextual search field to re-display the Search Tools menu.

SENDING AN EMAIL TO SHARED CONTACTS

Microsoft Outlook provides the ability to share a personal address book across an organization. However, once an address book has been shared, it does not appear in the Address Book drop-down list when selecting an address book to utilize.

Sharing Contacts with a Person in Your Organization
To share your contacts with a person in your organization, complete the following steps.

1. Select the Contacts option within Microsoft Outlook. Your contacts display.

2. From the toolbar, select the Share Contacts button. A new email displays.
3. The new email is configured to grant the recipient access to your contacts. You can select the checkbox that will insert a request to be able to view the contacts of the person to which you are granting access.

4. Select the To: button to select the person to which you want to grant access to your contacts. The Select Names screen displays.
5. Begin typing the name of the person to which you want to grant access to your contacts. The names listing will jump to the nearest match to the text you have entered.

6. Select the name of the person to whom you want to grant permission to access your contacts.

7. Select the OK button. The permissions email displays.

8. Enter a personal note in the body of the email.

9. When you have completed your personal message, select the Send button.

The invitation to access your contacts is sent to the recipient. Complete these steps to grant access permission to additional people.
Access Shared Contacts

To view shared contacts, complete the following steps.

1. Select the **Contacts** option within Microsoft Outlook. Your contacts display.

2. Select the **Open Shared Contacts** button. The *Open Shared Contacts* screen displays.

3. Select the **Name...** button on the *Open Shared Contacts* screen. The *Select Name* screen displays.

4. Begin typing the name of the person whose contacts you want to open. The names listing will jump to the nearest match to the text you have entered.

5. Select the name of the person whose contacts you want to open.
6. Select the OK button. The **Open Shared Contacts** screen displays.

![Select Name: Offline Global Address List](image)

7. Select the OK button on the **Open Shared Contacts** screen. Your **Contacts** display.

![Open Shared Contacts](image)
8. The shared contacts now display in the side panel, located on the left side of the screen.

Repeat these steps to open additional shared contacts.
CONTACT DORNSIFE TECHNOLOGY SERVICES

Campus Office:  
825 Bloom Walk, ACB 530  
Los Angeles, CA 90089-1486

Technical Support:  213-740-2775

E-mail: ts@dornsife.usc.edu